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1 Introduction
This configuration guide targets our partners and test customers for our DentalCAD platform.

This guide is valid for software versions released since 2015.

exocad DentalCAD is an advanced CAD software platform for dental applications.

This document helps you to customize the exocad DentalCAD platform.

We presuppose that readers of this document:

 are comfortable with editing XML files and understand the basic structure of the format

 understand the XAML technology

 understand the basics of graphics files (pixel resolution, alpha channel/transparency)

CAUTION

The given examples of XML files in this document are incomplete. They are not intended to be
copied into your configuration files verbatim.

In particular, ”...” denotes omissions thatmust be completed by you and is not literally part of the
file. It is used to identify skipped elements that are irrelevant and would distract the readers
attention while illustrating a specific part of the XML file.
For creating your XML files, please use all information given in this document and regard the
given fragments as examples.

1.1 How to Apply Changes to Configuration Files

Configuration files for the CAD software are stored in DentalCADApp\config. We ship a default configuration file named
defaultsettings.xml; its content varies across different software versions delivered by us.

To make it easier for our customers to apply their own configuration changes to new exocad version, the software also
checks and loads for a file called settings.xml in the same directory; if that file is present, the software loads it in ad-
dition to defaultsettings.xml. If the same configuration option is present in both defaultsettings.xml and
settings.xml, the value defined in settings.xml will override the setting from defaultsettings.xml.

Therefore, it is not recommended to make changes directly in defaultsettings.xml. Instead, create a new file
settings.xml (using defaultsettings.xml as template - you can remove all existing entries except for the lines
starting with <ApplicationSettingsCAD ...> and </ApplicationSettingsCAD>) and add your changes there.
Thisway,whenyou receiveanewsoftwareversion, youcansimply copyyour settings.xml file to thenewversion,without
having to re-edit the defaultsettings.xml of the new version and apply your changesmanually.

Note: Whenwemention (default)settings.xml in the following, we refer to an option that can be either configured in
settings.xml or defaultsettings.xml - the recommended way is to add it to settings.xml.

The same concecpt applies to the color configuration (colors.xml / defaultcolors.xml as well as colors.xaml
and defaultcolors.xaml in the UI skin configuration), although here we ship a colors.xml / colors.xaml file
with themost commonly adjusted color configurations - you can simply overwrite the colors.xml / colors.xaml with
your own version when you receive a new exocad version.

For DentalDB configuration, the file names are DentalDB\config\defaultsettings-db.xml (shipped with every
new release) and settings-db.xml (the place tomake your changes).

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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2 Colors
2.1 Skins (UI Elements)

Colors of UI elements such as buttonsmay be customized in the following files:

 DentalCADApp\Skins\generic\Common\Brushes\(Default)Colors.xaml

 DentalDB\Skins\generic\Common\Brushes\(Default)Colors.xaml

Skin colors¹ may be defined using one of the following formats:

 as RGB values coded as 6-digit hexadecimal numbers, such as #f7abed, or

 as aRGB values coded as 8-digit hexadecimal numbers, such as #EF584f7c.

INFO

Youmay use the same file in both directories to create the same style in DentalCAD and in
DentalDB.

For customizing UI elements, please follow the comments given in the skin files. These give an overview about the colors
that should be used (e.g. light or dark). In some cases, there are also explanations which parts of the UI are affected (e.g.
Expert Mode Toolbar). Customization should be straightforward using these comments. We do not provide additional doc-
umentation beyond that.

CHANGING COLORS

We highly recommend that you do neither use a dark color where a light color is suggested nor
the reverse!

2.2 Other Elements in DentalCAD

Colors of other elements inDentalCADsuchas the3Dviewerbackground,meshes,menusormenu iconsmaybecustomized
in DentalCADApp\config\(default)colors.xml.

The associated configuration entries in the XML file have the following structure:

<ArrayOfColorDefinition ...>

...

<ColorDefinition>
<Type>Antagonist</Type>
<Color>#ff4800</Color>
<SelectedColor>#e68bff</SelectedColor>
<Opacity>0.5</Opacity>

</ColorDefinition>

...

<ColorDefinition>
<Type>UnsegmentedJaw</Type>

¹For details, seew3schools.com/Html/html_colors.asp. An online color selection tool is available under 2createawebsite.com/build/hex-colors.html.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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<Color>#83827e</Color>
<Shine>0</Shine>

</ColorDefinition>

...

</ArrayOfColorDefinition>

Themeanings of the individual tags are explained in Table 1.

Tag Meaning

ArrayOfColorDefinition Root element

Type The 3D data type identifier. For examples of values andmeanings, see
Table 2

Color Defines the color in HTML-style notation², i.e. as RGB values coded as
6-digit hexadecimal numbers, such as #f7abed

SelectedColor Defines the color to be displayed if themesh is selected

Opacity Defines the transparency (accepts values in the range of [0..1])

Shine Defines the brightness (accepts values in the range of [0..1])

Table 1: Explanation of the color configuration file tags

Tag Meaning

Antagonist Scan data of antagonist

UnsegmentedJaw Scan data of a (partial) jaw

UnsegmentedTooth Scan data of a single tooth

Gingiva Scan data of a gingiva

ViewerBackgroundTop Color of background (top of screen)

ViewerBackgroundBottom Color of background (bottom of screen)

CutViewBubbleBackground Color of bubble background (duringmargin line detection)

CutViewBubbleArrow Color of bubble arrow

MarginColorOfLine Color of margin line

MarginColorOfDetectorLine Color of margin detector line

MarginColorOfControlPoint Color of margin control point

MarginColorOfControlPointSelected Color of selectedmargin control point

DefaultViewer3DTextColor Color of Text

Table 2: Examples of values for Type

²For details, seew3schools.com/Html/html_colors.asp. An online color selection tool is available under 2createawebsite.com/build/hex-colors.html.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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BACKGROUNDCOLORGRADIENT

Set ViewerBackgroundTop and ViewerBackgroundBottom to different values to create a
color gradient.

NO CHANGE of the freeforming color

Do not change the freeforming color for teeth (yellow), as it is often referred to in our
documentation!

Show/HideWindow

The colors for groups in the Show/Hidewindoware set by the associatedmesh color. Thesemay be customized by changing
the colors for the GroupColor.* entries in DentalCADApp\config\(default)colors.xml.

If you wish to change the background color of the menu title bars, you may customize the value of the tag Gray7 in
DentalCADAPP\Skins\generic\Common\Brushes\(Default)Colors.xaml.

If you prefer the Show/Hide window to becomemonochrome, set <ForceGroupSelectorSingleColor> to true in
DentalCADApp\config\(default)settings.xml and define the desired color as GroupSelectorDefaultColor
in DentalCADAPP\Skins\generic\Common\Brushes\(Default)Colors.xaml.

2.3 Menu Style

Additional settings that affect the UI such as themenu configurationmay be defined in
DentalCADApp\config\(default)settings.xml

The associated configuration entries in the XML file have the following structure:

<ApplicationSettingsProviderCAD>

...

<MenuItemFontSize>12</MenuItemFontSize>

...

</ApplicationSettingsProviderCAD>

The following XML tags can be added to override defaults for menu styling:

Tag Meaning

MenuItemFont Font for themenu. Default value is Segoe UI. Use only fonts that are
shipped withWindows by default, no user-installed TrueType fonts!
However, we recommend not to change themenu item font

MenuItemFontSize Font size formenu. Default value is 10

MenuItemCenterText Defines the alignment of the text. Default value is false (i.e. aligns
the text to top). Set to true to center vertically

Table 3: Menu style tags (continued on next page)

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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Tag Meaning

DisableMenuBorder Default value is true (i.e. disables themenu border). Set to false to
add a border

InvertIconsInMenu Default value is true (i.e. inverts the colors of themenu icons - so
that the black icons will be displayed in white). Set to false to
disable inverting of icons (icons will then be displayed either in the
original color from the icon file, or in the color MenuIconColor if
ColorizeMenuIcons is set to true)

ColorizeMenuIcons Default value is false (i.e. colorizesmenu icons in a specific color).
You will need to set the specific color in colors.xml (keyword
MenuIconColor). Set to true to color icons

MenuIconColor Defines the color of menu icons. This will only be applied if
ColorizeMenuIcons is set to true and InvertIconsInMenu is
set to false

MenuIconFrameColorCount Defines the number of colors for menu icon frames (icon background
box). The default value is 8. If you wish to usemore than 8 colors, add
additional IconBackgroundMultiColor.*-entries to
colors.xml (add .8, .9, .10 ...). Hint: Set to zero to disable
colored icon frame completely

Table 3: Menu style tags

The following tags in DentalCADApp\config\(default)colors.xml also affect the coloring of menu items:

 MenuTextColorSelected (for hover effect)

 MenuTextColorUnselected

 MenuBackgroundColorSelected (for hover effect)

 MenuBackgroundColorUnselected

 MenuSeparatorColor

 MenuInfoTextFontColor

2.4 DentalDB

Colors for the tooth definitions inDentalDBmay be configured in DentalDB\config\(default)colors-db.xml. How-
ever, we do not recommend to change them.

2.5 Other Elements in DentalDB

Changing thematerial buttonsmay be done in:
DentalDB\Skins\generic\DentalDB\NamedStyles\IndicationDefinitionDialogStyles.xaml:

For changing the height of thematerial buttons, adapt the value under DataTemplate > Grid > Height.

For changing the number of columns, adapt the value under ItemsPanelTemplate > UniformGrid > Columns.

2.6 NestingMaterialblock Library

The text color for the material block names is configurable in DentalCADApp\config\(default)colors.xml. The
associated tags are: Nesting.DisplayBlockNameBrushDefault, Nesting.DisplayBlockNameBrushSameFile

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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and Nesting.DisplayBlockNameBrushSameID.

3 Data Storage Paths and Files
Paths for data storage are configured in DentalDB\config\(default)settings-db.xml.

3.1 File Storage

The associated configuration entries in the XML file have the following structure:

<ApplicationSettingsDB ...>

...

<DataStoragePath>C:\CAD-Data</DataStoragePath>

...

<PathTemplate>%d_%n-%s</PathTemplate>
<ExternalNestingQueueDir>C:\TEMP\QUEUE</ExternalNestingQueueDir>

...

</ApplicationSettingsDB>

Themeanings of the individual tags are explained in Table 4.

Tag Meaning

ApplicationSettingsDB Root element

DataStoragePath Defines themain path where all job related files will be stored. Relative
or absolute path specifications are allowed, e.g. “.\CAD-Data” or
“C:\exocad\CAD-Data”. This may even point to a network drive

PathTemplate Defines the naming scheme for project directories (which will be
created as subdirectories of DataStoragePath ). For the available
placeholders, see below

ExternalNestingQueueDir Sets the directory for distributed production queuemanagement
(common exchange format between hyperDent and exocad). This may
also point to a network drive. For important information concerning
this tag, see below

Table 4: Explanation of the data storage path tags

Setting ExternalNestingQueueDir

Setting ExternalNestingQueueDir needs to be done

 in the DentalDB\config\(default)settings-db.xml file and

 in the DentalCADApp\config\( default)settings.xml file.

Both valuesmust be configured the sameway.

Also, note that subdirectories matching the material short name of all locally produced materials (e.g. TI, ZI, ... ) must be
created within the queue directory.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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Placeholders

The following placeholders are available for PathTemplate:

 %d: date (e.g. 2015-01-19)

 %n: practice number

 %p: practice name

 %f: patient first name

 %l: patient last name

 %c: country

 %s: sequential number whenmultiple jobs with the same practice number and date are created

CHANGING THE PLACEHOLDERS

It is highly recommended that you use the default setting %d_%n-%s as PathTemplate.
This will lead to directory names like 2015-01-19_00001-001.

Youmay introduce an additional doctor/patient hierarchy by setting PathTemplate to
%p\%l,%f\%d_%n-%s.
This will lead to directory names like Dr. Smith\Doe, John\2015-01-19_00001-001.

3.2 Database Storage

The location of the database file (DentalDB_V3.sqlite) may also be customized.

The associated configuration entry in the (default)settings-db.xml file has the following structure:

<ApplicationSettingsDB ...>

...

<SQLSettings>
<ConnectionString>Data Source=..\db\DentalDB_V3.db;Version=3</ConnectionString>
<SQLDialect>NHibernate.Dialect.SQLiteDialect</SQLDialect>
<DriverClass>NHibernate.Driver.SQLite20Driver</DriverClass>

</SQLSettings>

...

</ApplicationSettingsDB>

Themeanings of the individual tags are explained in Table 5.

Tag Meaning

ApplicationSettingsDB Root element

ConnectionString Defines the location of the database file (DentalDB_V3.sqlite).
Replace the ..\db\DentalDB_V3.db part by the desired path (may
be relative or absolute). Thismay even point to a network drive to allow
access bymultiplemachines. Do not omit the part “;Version=3”

Table 5: Explanation of the data base storage path tags (continued on next page)

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.

page 11/21



M
KT

CG
–0
02

–1
50

9
CG - Customization of exocad’s Dental CAD Platform

Tag Meaning

SQLDialect Defines the SQL dialect. Might need to be replaced by the settings for
your database backend ³. See below for a list of exocad’s supported
database backends

DriverClass Defines the driver class. Might need to be replaced by the settings for
your database backend 3. See below for a list of exocad’s supported
database backends

Table 5: Explanation of the data base storage path tags

For large installations (over 20 machines accessing the same database), sharing an sqlite file on a network drive is not an
ideal solution, due to performance/scalability constraints. For those large installations, exocad‘s DentalDB also supports
the following database backends:

 Microsoft SQL Server 2000 and 2005

 mySQL Enterprise

 Oracle 9i and 10g

4 Buttons (DentalDB)
Buttonsmay be customized in DentalDB\config\(default)settings-db.xml.

4.1 Adding Launch Buttons

Add or remove items within <StartButtonList> to add or remove buttons. The associated configuration entries in the
(default)settings-db.xml file have the following structure:

<ApplicationSettingsDB ...>

...

<StartButonList>

...

<StartButton>
<Icon>ScanIcon</Icon>
<Caption>Scan</Caption>
<ExecPath value="C:\Scanner\Scanner.exe">

<Params value="%p"/>
</ExecPath>

</StartButton>

...

</StartButonList>

...

</ApplicationSettingsDB>

Themeanings of the individual tags are explained in Table 6.

³Additional information concerning the SQL configuration options is available under developer.jboss.org/wiki/DatabasessupportedbyNHibernate.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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Tag Meaning

ApplicationSettingsDB Root element

Caption Defines the text displayed next to the button. This might be a keyword
(e.g. ScanButton) that refers to a translation in the language file(s).
The tooltip displayed to the user will be the translation of
ScanButton.ToolTip

ExecPath Defines the path to the file to be launched. This may be specified
relative to the location of DentalDB.exe (e.g.
“..\..\DentalCADApp\bin\DentalCADApp.exe”)

Params Defines the command line arguments. %p will be replaced by the path
of the currently loaded project file (.dentalProject). For further
options, see the comments in the XML file

Table 6: Explanation of the launch button tags

4.2 Enabling / Disabling Import From Intraoral Scanner (“iTero Import”)

Upload and import buttonsmay be disabled.
The associated configuration entries in the (default)settings-db.xml file have the following structure:

<ApplicationSettingsDB ...>

...
<ScanImport01Enabled>0</ScanImport01Enabled>

...
</ApplicationSettingsDB>

If you wish the import button to be enabled, set ScanImport01Enabled to 1.

4.3 FTP Server

By default, the FTP upload button is not displayed. If you wish to display the FTP upload button, you need to rename the file
ftpconfig.xml.sample in DentalDB\config to ftpconfig.xml.

FTP server configurations may be set in ftpconfig.xml. Under <FTPAccess>, set <ftpHost> to your desired server,
including the ftp:// prefix.
Example: <ftpHost>ftp://ftp.examplecompany.com</ftpHost>.

The <ftpdir> tag defines the target directory on the ftp server. Typically, you will want to set this to /. <ftpuser> and
<ftppass> may be used to force a specific username/password; if left empty (recommended!), the user can type in user-
name and password himself.

If you have troublewith your firewall not letting encrypted FTP connections through, you can configure encryption using the
<FTPEncryptionType> tag (commented out by default – remove the <!-- and --> to enable the option).
Possible values are:

 ForceEncryptAll (safe – default)

 ForceEncryptControlConnection (encrypt only login, don‘t encrypt transferred data. Unsafe!)

 NoEncryption (do not encrypt anything. Very unsafe!)

Upload file selection presetsmay be set under <StartUploadFiles>. Please look at the existing entries for examples.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
Copying, publishing, extracting content or transfer to a third party is prohibited without agreement of exocad GmbH.
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IMPORTANT

Encrypted FTP is troublesomewhen firewalls are involved!

If you want a file transfer solution that is both secure and trouble-free, use dentalshare instead.
Thanks to better compression algorithms, this will also result inmuch faster transfer speeds.

4.4 dentalshare

All dentalshare users are assigned to a group. These groups are configurable for both up- and download.

4.4.1 Configuring a Group

INFO

This is only relevant if ”dentalshare Project-Import” is enabled in user configuration.

Configurations for dentalshare groupsmay be set in DentalDB\config\defaultsettings-DentalShare.xml.
Change the content of the DefaultUserDomain tag to your dentalshare domain.

If you prefer different configurations for upload groups, youmay set this in:
DentalDB\config\uploadsettings-DentalShare.xml.
Change the content of the Domain tag to your dentalshare domain.

4.5 Disabling dentalshare Button

By default, dentalshare is enabled and the upload button is visible in the DentalDB tool bar. To disable it, simply delete the
uploadsettings-DentalShare.xml file.

5 Switching BetweenDifferentMaterial or Indication Configurations
For editing the list of materials, parameters and indications, we provide the following tool:
DentalDB\bin\WorkParamsConfigTool.exe. This tool should not be delivered to end users.
The storage location of materials, parameters and available indications is DentalDB\config\WorkParamsDB.xml.

Additional presets for materials, parameters and indications may be set by creating additional files in the
DentalDB\config folder, following the naming scheme WorkParamsDB-<XYZ>.xml. <XYZ> needs to be replaced by
an appropriately chosen keyword, e.g. WorkParamsDB-MyMillingCenter.xml. This will appear as “MyMillingCenter”
in the configuration dialog which is presented to the user to choose from.

6 Changing theMaterial Selection Layout
The layout for thematerial selectionmay be customized in:
DentalDB\Skins\generic\DentalDB\NamedStyles\IndicationDefinitionDialogStyles.xaml.

Images of materials are placed in the DentalDB\icons\material folder. The image needs to be a 400x400 pixel
graphic. The naming scheme is NAME.Material.png. DentalDBwill automatically selectmaterial images to be displayed
with tag Material/ShortName from config\WorkParamsDB.xml. In order to match a new material image to the
correspondingmaterial, the new image simply needs to be correctly named and placed in the material folder.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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7 Changing the Tooth Selection Control
For customers with high-volume orders, we offer customization of the tooth selection control. Please contact us for details.

8 Background Images and Logos
8.1 CADModule Background

Save your background image as BackgroundImage.xaml and place it in the DentalCADApp\icons folder. It will be
automatically loaded instead of the exocad logo.

If you wish to use a PNG instead of a XAML file, you may store your image as BackgroundImage.png and delete the
BackgroundImage.xaml file. The image will be loaded in the original size, with no scaling applied. Make sure that the
alpha channel (transparency) is properly set. This is especially required if you wish a color gradient as background.

Thepositionof thebackground imagemaybecustomized in the DentalCADApp\config\(default)settings.xml file
as follows:

<ApplicationSettingsCAD ...>

...

<BackgroundImagePosition>TopLeft</BackgroundImagePosition>

...

</ApplicationSettingsCAD>

Possible values are:

 TopLeft

 TopRight

 LowerLeft

 LowerRight

8.2 DentalDB Bottom Logo

In order to change the DentalDB bottom logo, replace the DentalDB\icons\BottomLogo.xaml file by your logo.
If you wish to use a PNG instead of a XAML file, you may store your logo as BottomLogo.png and delete the file
BottomLogo.xaml.

NOTE

Sample files for customizing background logos are available for download in the secure area of
our website.

COPYRIGHT

Do not putmisleading copyright notices in the logos (e.g. “Copyright © [Your CompanyName]”)!

The exocad Dental CAD platform is copyrighted by exocad GmbH and Fraunhofer IGD. If you wish
to include a copyright notice, use “Copyright © exocad GmbH. Licensed to [Your CompanyName]”.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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9 Changing the Product Names
Product names for DentalDB and DentalCADmay be customized.

DentalCAD

In DentalCADApp\config\(default)settings.xml, add/edit the content of the VendorProductName tag to a
name of your choice, e.g. <VendorProductName>My Company Dental CAD</VendorProductName>.

DentalDB

In DentalDB\config\(default)settings-db.xml, define VendorProductNameDB the sameway.

10 Integration of Splash Screens; Disabling CustomizationOptions
Splash screens may be customized for DentalDB, DentalCADApp and for several modules. You may change the splash
screens by replacing the default files.

The DentalDB\icons folder contains the default splash screen for the DentalDB (splash.png).

The DentalCADApp\icons folder contains the default splash screens for:

 DentalCADApp (splash.png)

 Nesting (splash\nesting.png)

 ModelCreator (splash\modelcreator.png)

 ExoViewer3D (splash\viewer.png)

We can also disable the possibility to change CAD background icon and product names in customer specific versions com-
piled for large OEMs. Therefore, the configuration options described heremay not work with all releases of our software.

NOTE

Sample files for customizing background logos are available for download in the secure area of
our website. Since you cannot change the splash screens yourself, we also provide a „preview tool“
(available in the secure area of our website as well), which allows you to preview your splash
screens, before sending them to us for the purpose of integration with the executable file.

11 Replacing Icons
Vector icons are stored in XAML format. Although it is possible for you to replace icons yourself, please note that special
considerations are necessary to generate the XAML files correctly. If you have difficulties generating correct files, we provide
you contact information of an icon designer who has experience creating XAML icons for exocad. We strongly recommend
to use Inkscape 0.48 to create the XAML files. Other programs or software versionsmay ormay not work.

It is important that the XAML icons you replace have the exact same dimensions as the original icons. To find outwhat these
are, open the original XAML file in a text editor, and look for the Width and Height fields of the first Canvas tag in the
file. Then, create a new file with the same dimensions.

Pleasemake sure that the vector graphics do not contain any text fields; if you use fonts during the design of your icons, use
Inkscape’s ”Path->Object to Path” function to convert it to a path. Also, make sure that there are no invisible layers before
saving to XAML, as this will bloat the size of the XAML file and slow down startup of the exocad software.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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Converting SVG to XAML

If your icons are not provided in XAML format but as SVG, youmay perform the following steps in Inkscape to convert these
icons to XAML:

Step 1: Load the SVG file in Inkscape.

Step 2: Set the color to the original color.

Step 3: Set the size to the original size of the XAML file you are replacing (32x32 formost icons). Refresh the centering of
the graphic.

Step 4: Perform “Path > Object To Path”.

Step 5: Export the image asMicrosoft XAML.

Converting XAML to PNG

We use XAML for our icons for several reasons, e.g. their scalability. As some icon designers use other file formats, youmay
wish to provide them the icons in a format they can handle. This will help your designer to understand what the icon names
stand for.

We offer a tool for converting the icons from XAML to PNG format which youmay activate by using the following command
line option: DentalCADApp.exe /ConvertXamlIconsToPNG

IMPORTANT

Delete the PNG files in the icons folder before delivering! As the software loads all icons in this
folder when starting, having the icons saved as both XAML and PNG format will slow down the
starting process!
We do not recommend to replace the XAML icons by PNG files!

11.1 Arrow Icons

The arrow icons are stored in DentalCADApp\icons.
In detail, these are: InArrowIcon, OutArrowIcon, DownArrowIcon, UpArrowIcon, LeftArrowIcon,
RightArrowIcon.

11.2 Toolbar Icons

When changing the toolbar icons, please consider the following:

 Toensure, that the toolbar iconsfit to thenewsoftware look, the softwarewill turn colored icons tomonochrome icons.
It is recommended to choose amonochrome icon design from the start. For shading, please use the alpha channel.

 Some icons are displayed within a circle. This circle is not part of the icon file and is not customizable. If you prefer
toolbar icons without circles, youmay choose one of our alternatives which you will find in the following directory:
DentalCADApp\Skins\generic\Common\NamedStyles.

We offer the following files for toolbar button styles:

 Standard: ToolBarButtonStyle.xaml

 Alternative: ToolBarButtonStyle_alternative.xaml

 Alternative 2: ToolBarButtonStyle_alternative2.xaml

By default, we use the first file. If you decide to choose one of the alternative files, you need to rename the XAML file
name to ToolBarButtonStyle.xaml (overwriting the old file) to apply the change. For screenshots showing the

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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different styles, see Figure 1.

 Colors of icon, circle and background are customizable for both the toolbar (on the right) and the expertmode toolbar.
Entries that are related to the expert mode toolbar are marked with Expert* in (default)colors.xaml. Other
elements such as the “Back” button in DentalDB dialogs use one of the basic colors (e.g. BrandColor1) for icon and
circle.

(a) Standard (b) Alternative (c) Alternative 2

Figure 1: Toolbar button styles

11.3 MainWindow Icon

The MainWindow.ico file is placed in the DentalCADApp\icons folder. While the software is running, this iconwill be
displayed in the top left and in theWindows taskmanager.

The icon of the executable itself cannot be changed. However, you may create a shortcut (manually or using Windows in-
staller) to the executable and then replace its icon⁴.

12 Changing Behavior of Certain Design-Related Algorithms
The behavior of certain algorithms that effect the output characteristics can be adjusted to match your preferences. If you
arewilling to experiment and run test series to findoutwhatworks best for you, you can change the parametrization of some
of the internal algorithms used.

12.1 Cement Gap Transition Smoothness

Recent exocad versions (since 2015) generate smooth cement gap transitions by default, so configuration of this option
should no longer be necessary.

⁴See 7tutorials.com/how-change-icon-shortcut
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12.2 Shape Preservation During Adaptation of ToothModels to the Preparation

You can configure the algorithm‘s behavior during the adaptation of the model teeth using two parameters, to control the
trade-off between “best possible preservation of the original tooth shape” (less adaptation) and “smoothest adaptation to
the individual patient situation” (more adaptation).

This can be adjusted in DentalCADApp\config\defaultparameters.xml. There are two parameters:

CrownAdaptationMarginForShapePreservation

This defines the zone around themargin line thatmay have its shape heavily changed during adaptation, inmillimeters.
Higher value = a larger portion of the tooth will be deformed
Lower value: a larger portion will have its original shape preserved (thus resulting in an overall more edgy and less smooth
shape).

CrownAdaptationShapePreservation

This defines the strength of the shape preservation.
Low value = Less shape preservation, more round and smooth result.
Larger value =More shape preservation, thusmore edgy transitions. Note that the scale is nonlinear!
Useful values to experiment with are 0, 0.0001, 0.001, 0.01, 0.1. Higher values are not recommended.

12.3 Margin Line Smoothness / Control Point Distance inMargin “Edit”Mode

When editing themargin line using the „edit“ tab, some customers prefer to havemany control points with narrow spacing,
for high accuracy (default configuration), whereas others like to have a larger spacing between control points, resulting in a
more smoothmargin line (less accuracy, default behavior of many competitors‘ products).
This can be controlled using three parameters:

1. PreparationMarginControlPointInitialDistanceStepDistance
Maximumdistance of two control points, independent of the shape of the curve.

2. PreparationMarginControlPointRefinedDistanceStepDistance
Minimumdistance between two control points, in areas of high curvature.

3. PreparationMarginControlPointRefinementDeviation
If point on detectedmargin has higher a distance than this value from the straight line between two control points, an
additional control point will be inserted.

Two examples:

Even distribution of control points with distance 1mm:

PreparationMarginControlPointInitialDistanceStepDistance = 1.0
PreparationMarginControlPointRefinedDistanceStepDistance = 1.0
PreparationMarginControlPointRefinementDeviation= 1000

Typically, distance 1mm, but going as low as 0.5mmdistance in zones of high curvature:

PreparationMarginControlPointInitialDistanceStepDistance = 1.0
PreparationMarginControlPointRefinedDistanceStepDistance = 0.5
PreparationMarginControlPointRefinementDeviation= 0.05

12.4 Behavior of the “Additional Spacing / Occlusal” Setting

By default, when using the “occlusal” slider under “additional spacing”, an additional spacing in occlusal direction will be
applied evenly everywhere – also near themargin line.

©2010–2015 exocad GmbH | Julius-Reiber-Str. 37 | D–64293 Darmstadt
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If you do not like the default behavior, you can change this in the (default)settings.xml file by setting the option
<AdditionalSpacingZNearPrepline>false</AdditionalSpacingZNearPrepline> to change the behavior. Af-
ter setting this option, no additional Z spacing will be applied in “the untouchable near margin line”, defined by the setting
“Don‘t block out near prepline” in the crown bottom dialog.

NOTE

We added a new option “Occlusal (top)”. Try using this option first (available in the GUI) before
changing the AdditionalSpacingZNearPrepline option.

12.5 ToothModel Smoothing

If you prefermore smooth anatomic shapes, there are options to smooth toothmodels on load.

Smoothmodels (range 0.0-1.0):
<ToothModelSmoothing>1.0</ToothModelSmoothing>

Chewing surface (range 0.0-1.0):
<ToothModelSmoothingChewingSurfaceFactor>1.0</ToothModelSmoothingChewingSurfaceFactor>

Radius (recommended to be left at 0.5):
<ToothModelSmoothingRadius>0.5</ToothModelSmoothingRadius>

12.6 Close the Top of the ScrewHoles for Implant Based Structures

If you wish to close the top of the screw holes for implant based structures, youmay add the following tag into
DentalDB\config\(default)settings-db.xml: <ImplantCloseHoles>true</ImplantCloseHoles>

13 Controlling Coordinate System of Output Files
13.1 Aligning to Scan Data

By default, the output STL files are rotated so that the insertion axis is aligned with the Z axis. In some cases, it may be
desirable to keep the original coordinate system, so that the output files remain properly aligned to the scan data.

This can be controlled with the following option, respectively:

For ‚normal‘ restorations:
<RotateRestorationsToZAxis>false</RotateRestorationsToZAxis>

For abutments and screw retained crowns:
<RotateAbutmentsToZAxis>false</RotateAbutmentsToZAxis>

13.2 Keeping Implant-Based Restorations in Implant Library Coordinate System

If youwish to retransform the output files of implant-based restorations (abutments and screw retained crowns) to the orig-
inal coordinate system of the implant library, use this option:

<RotateAbutmentsToImplantLibrary>true</RotateAbutmentsToImplantLibrary>

14 Miscellaneous
14.1 Dongle Information

In order to write out the dongle information, you may use the parameter WriteDongleInformationFileAndExit
when starting the DentalCADApp.exe. This will cause the executable to onlywrite the dongle information into a filewith-
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out starting the DentalCAD software.

Example: DentalCADApp.exe /WriteDongleInformationFileAndExit=C:\temp\xyz.xml

15 Support
We provide 3rd level support in case of technical questions/ issues related to our products, usage of the software, exoportal
or the like. Our software trainers can also be contacted for quick on-line demonstrations of new features. To contact our
support team, please send an email request to the email address of your region. Your email will automatically create a ticket
in our support system exoportal. To follow-up, you can reply to our response email.

IMPORTANT

To resolve your issue quickly and smoothly, please:

 send a separate email for each issue. Please do not introduce new topics to an existing email
conversation!

 do notmodify the subject line of the support reply email!

 provide all necessary data (project file, scan data, construction files) and additional
information (software build number, OS etc). Without this data, a problem (technical or
usage) cannot be reproduced and will not be handled!

For the contact information for your support region, please visit exocad.com/secure-area/support.
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